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Questa masterclass ¯ una esperienza di formazione e orientamento 
allõinterno del campus, per studenti di scuola superiore, che vede 
combinate visite ai laboratori di informatica con interventi informativi 
interattivi su argomenti scientifici inerenti alla programmazione 
informatica e alla robotica. Le attivit¨ dovrebbero aver luogo 
allõinterno dellõuniversit¨ e utilizzare laboratori disponibili o altro 
materiale.  

C O M E  U T I L I Z Z A R E  
L A  R I S O R S A  

 

 

Introduzione 
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L'argomento dellõattivit¨ formative ¯: Introduzione ai sistemi Arduino 
e alla programmazione per i sistemi embedded costruiti su moduli 
Arduino. Lõapproccio ¯ basato sullõutilizzo di un progetto pronto 
allõuso che ¯ inizialmente presentato agli studenti, insieme alle 
informazioni sui costrutti di programmazione di base di un linguaggio 
di programmazione. Cela le complessit¨ della programmazione 
tradizionale per sistemi embedded e microcontrollori dietro a 
paradigmi e programmi elementari, rendendo la programmazione 
semplice e adatta a principianti. Inoltre, la presentazione iniziale 
include informazioni sui sistemi embedded, e sulla programmazione ð 
interrupt, eventi, funzioni di callback, event loop, etc. La 
programmazione a eventi e interrupt ¯ il modello di programmazione 
di base, utilizzato in tutti i moderni sistemi di controllo e correlato 
anche alla gestione dellõinput da dispositivi remoti e dispositivi I/O 
collegati a un controller. Dopo la presentazione iniziale, gli studenti e 
gli insegnanti accompagnatori sono invitati a lavorare sulle possibili 
estensioni sul progetto di una stazione meteo intelligente. 

 

 

 

Questa masterclass ¯ indirizzata a studenti delle scuole superiori che 
gi¨ hanno avuto delle esperienze con la programmazione e hanno 
conoscenza dei circuiti elettrici e degli schemi. Tale conoscenza 
preliminare consentirebbe loro di comprendere facilmente i concetti di 
programmazione di base di Arduino. 

 

 

 

Gli studenti dovrebbero avere esperienze precedenti nellõuso delle 
variabili, costrutti if-then-else, loop e funzioni di qualsiasi linguaggio di 
programmazione, in modo da poter capire senza problemi come il 
linguaggio Processing supporti tali concetti di programmazione.

 

 

 

Due o tre ore. 

 

 

 

 

 

Studenti universitari o insegnanti che hanno esperienza 
nellõinsegnamento di corsi introduttivi sulla programmazione 
(preferibilmente usando il linguaggio di programmazione C/C++) e 
corsi relativi agli schemi elettrici. 

 

 

 

Comprensione generale di concetti di programmazione di base nel 
linguaggio Processing (C/C++): 

¶ Variabili boleane, integer e stringa 

¶ Variabili locali e globali 

¶ Record e strutture 

A R G O M E N T O  
D E L L A  L E Z I O N E  

 

 
L I V E L L O  D I  
DIFFICOLTê/ETê 

S T U D E N T I  

C O N O S C E N Z E  
P R E L I M I N A R I  
R I C H I E S T E  

 

T E M P O  R I C H I E S T O  
P E R  
LôIMPLEMENTAZIO
N E  

 

I S T R U T T O R I / D O C E

N T I  

C O N O S C E N Z E  
A C Q U I S I T E  E  
C O M P E T E N Z E  
S V I L U P P A T E  -  

S T U D E N T I  

Attivit¨ e piano di lezione 
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¶ espressioni boleane e aritmetiche 

¶ funzioni 

¶ oggetti e metodi 

Comprensione generale di concetti della programmazione a eventi e 

interrupt: 

¶ Interrupt 

¶ Timer 

¶ Eventi e callback 

¶ Event loop 

 

 

 

Presumendo che i docenti accompagnatori siano professori di scienze 
informatiche e che, quindi, gi¨ insegnino programmazione, potrebbero 
comunque apprendere le regole sintattiche di C/C++  a supporto della 
programmazione procedurale e i paradigmi di programmazione a 
oggetti, eventi e interrupt. Gli insegnanti accompagnatori impareranno 
a usare la piattaforma Arduino IDE, in modo da poterla  
successivamente utilizzare anche nelle loro lezioni. 

 

 

 

Il personale universitario e gli studenti universitari coinvolti 
svilupperanno competenze di comunicazione scientifica ð soprattutto, 
competenze per lõinsegnamento e la spiegazione del funzionamento dei 
dispositivi Arduino a unõaudience con livello meno avanzato. 
Dimostreranno anche come poter utilizzare tali dispositivi nello 
sviluppo di progetti fai-da-te per lõautomazione domestica. 

 

 

 

- Una lavagna bianca (pu¸ essere utile per spiegare il codice presentato 
con diagrammi schematici) 

- Proiettore e computer connesso a Internet per mostrare ai 
partecipanti le letture della stazione metereologica domestica usata in 
questa master class. 

-Computer connessi a Internet dove i partecipanti possono partecipare 
in gruppi per usare e mixare il codice in questione. Gli studenti 
useranno la piattaforma Arduino IDE (http://www.arduino.cc), un 
ambiente gratuito per la programmazione del microcontrollore. In 
generale, Arduino ¯ una piattaforma di prototipazione elettronica open 
source basata su hardware e software flessibili e facili da usare. 

-I sistemi embedded comunicano con lõambiente, ricevendo segnali da 
pi½ sensori e interagendo con esso, controllando luci, display, motori e 
altri dispositivi. Per esempio, se volessimo costruire una òstazione 
meteo per la casaó, dovremmo costruire una soluzione hardware e 
scrivere il software appropriato. Per lõhardware, abbiamo bisogno di un 
microcontrollore (praticamente un mini-computer) e una periferica. 
Per una stazione metereologica domestica molto semplice, avremo 

C O N O S C E N Z E  
A C Q U I S I T E  E  
C O M P E T E N Z E  
S V I L U P P A T E  -  
I N S E G N A N T I  

 

C O N O S C E N Z E  
A C Q U I S I T E  E  
C O M P E T E N Z E  
S V I L U P P A T E  -   
P E R S O N A L E  
U N I V E R S I T A R I O  O  
S T U D E N T I  
U N I V E R S I T A R I  

 

 
M A T E R I A L E  
N E C E S S A R I O  P E R  
Lô 
I M P L E M E N T A Z I O N E  
DELLôATTIVITê 

 

http://www.arduino.cc/
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bisogno di sensori per la temperatura, umidit¨, pressione barometrica, 
polvere, fumo, gas, etc.  

 

 

 

Questa masterclass ¯ divisa in 3 parti: 

1. Intervento/lezione informativi: questa parte dovrebbe aver 
luogo in una sala conferenze o in unõaula magna dellõuniversit¨ 
organizzante. Questa parte inizia con il benvenuto e una breve 
attivit¨ rompi ghiaccio, volta a parlare delle esperienze 
precedenti degli studenti nellõambito della programmazione e 
dellõelettronica. Subito dopo, lõesperto presenta la stazione 
meteo domestica sviluppata, gli elementi elettronici usati e il 
codice sviluppato.  

2. Attivit¨ pratica/ visita al laboratorio: questa parte ha luogo in 

un laboratorio. Specificatamente, gli step della seconda parte 

sono i seguenti: 

Step 1. Gli studenti e i loro accompagnatori si spostano nel 
laboratorio dove avr¨ inizio la sessione relativa. 

Step 2. Gli studenti sono divisi in gruppi di 2-4 persone (a seconda 
del numero di studenti e computer disponibili) 

Step 3. Ai gruppi viene richiesto di apportare delle modifiche al 
codice della stazione meteo. Possono sia sviluppare il proprio 
mixaggio o seguire i compiti specifici stabiliti dagli organizzatori. 

Step 4 ð Il personale universitario e gli studenti coinvolti nella 
master class hanno il ruolo di facilitatori, per aiutare i gruppi di 
studenti a sviluppare i cambi/mixaggi selezionati. 

3. Autoriflessione da parte degli studenti: questa parte dovrebbe 
avvenire nella sala conferenze o aula magna. I gruppi sono 
invitati a comunicare le difficolt¨ incontrate e come hanno 
risolto qualsiasi tipo di problema. Dopo la presentazione degli 
studenti, gli organizzatori chiudono il meeting, fornendo 
ulteriori link e informazioni per coloro che vogliono sapere di 
pi½ sugli argomenti della master class.  

 

 

 

https://learn.sparkfun.com/tutorials/weather-station-wirelessly-
connected-to-wunderground 

http://cactus.io/projects/weather/arduino-weather-station 

https:// circuitdigest.com/ arduino-projects 

https:// howtomechatronics.com/ arduino-projects/  

https:// www.electronicshub.org/ arduino-project-ideas/  

https:// www.hackster.io/ arduino/ projects?sort=trending&page=3 

https:// create.arduino.cc/ projecthub?page=1&sort=trending 

 

S U D D I V I S I O N E  
DELLE ATTIVITê 

 

L I N K  E  R I S O R S E  
U T I L I  

 

 

https://learn.sparkfun.com/tutorials/weather-station-wirelessly-connected-to-wunderground
https://learn.sparkfun.com/tutorials/weather-station-wirelessly-connected-to-wunderground
http://cactus.io/projects/weather/arduino-weather-station
https://circuitdigest.com/arduino-projects
https://howtomechatronics.com/arduino-projects/
https://www.electronicshub.org/arduino-project-ideas/
https://www.hackster.io/arduino/projects?sort=trending&page=3
https://create.arduino.cc/projecthub?page=1&sort=trending
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Per ulteriori informazioni su Arduino e risorse di apprendimento a 
livello base sui programmi Arduino 

https://www.arduino.cc/en/Main/Education 

 

 

 

Questa risorsa ¯ basata sulle informazioni su Arduino e su progetti 

orientativi, disponibili allõindirizzo:  

https://www.arduino.cc/en/Main/Education 

 

U L T E R I O R I  
L E T T U R E  
C O N S I G L I A T E  

 

F O N T I  U T I L I Z Z A T E  
P E R  L O  S V I L U P P O  
D E I  M A T E R I A L I  

 

https://www.arduino.cc/en/Main/Education
https://www.arduino.cc/en/Main/Education
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Stanimir Yordanov (Universit¨ Tecnica di Gabrovo, Bulgaria) 

 

 

 

La maggior parte dei software oggi disponibili fornisce potenti 
linguaggi, per consentire agli utenti finali una personalizzazione 
flessibile e un ricco sviluppo interattivo dei contenuti. A tal proposito, 
la conoscenza di concetti della programmazione informatica ¯, 
necessaria per molti lavoratori della conoscenza, scienziati e ingegneri 
inclusi. Ne consegue che, molti dipartimenti di educazione superiore 
hanno incluso nel loro programma corsi di programmazione base. 
Diversi paesi hanno ampliato il loro programma nellõeducazione 
secondaria, ma anche primaria, per affrontare lo sviluppo di 
competenze base di programmazione. Lõimportanza della 
programmazione informatica ha ricevuto sempre pi½ attenzione, grazie 
a campagne di sensibilizzazione sul coding come la Europe Code 
Week. Opportunit¨ di apprendimento informale sono anche offerte in 
molti paesi seguendo l'approccio organizzativo dei Coding Club. 
Tuttavia, in diverse occasioni, i corsi introduttivi seguono il 
tradizionale approccio di presentare una ad una le caratteristiche di un 
dato linguaggio di programmazione, con esempi poco applicabili alla 
realt¨ e pochi esercizi di programmazione. Unõalternativa pi½ 
accattivante di promuovere conoscenze di programmazione a livello 
base ¯ data dallõ utilizzo di esempi significativi e progetti di coding 
come i sistemi e dispositivi embedded. Questo ¯ lõapproccio adottato 
nella master class. Seguendo questa Master Class, gli studenti 
partecipanti avranno l'opportunit¨ di comprendere i metodi di base per 
la progettazione, la programmazione e la costruzione di sistemi 
embedded. 

 

 

 Arduino ̄  stato recentemente introdotto nei programmi degli istituti 
professionali e nellõistruzione secondaria superiore in molti paesi 
europei. Di conseguenza, cõ¯ una crescente popolarit¨ per lõutilizzo dei 
sistemi Arduino, in ambito educativo. Questa tendenza si riscontra 
nellõuso dei moduli Arduino come sistema embedded in molte 
piattaforme e applicazioni e nella sua crescente popolarit¨ 
nellõautomazione industriale e domestica e nell'Internet of Things (IoT 

 

REDATTORI 

INTRODUZIONE 

ALLôARGOMENTO 

 

LôIMPORTANZA 
P E R  L A  V I T A  
Q U O T I D I A N A /  
LôECONOMIA/LA 

S O C I E T" 

 

Scheda conoscenze di base 
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 Definizione di termini.  

Durante lõattivit¨, devono essere definiti i seguenti termini: 

- Sistemi Arduino 

Arduino ¯ un microcontrollore open-source con un hardware e un 
software di facile utilizzo (un linguaggio di programmazione e un 
ambiente di sviluppo integrato - il cosiddetto IDE). 

I controller Arduino sono relativamente economici e il programma di 
sviluppo integrato (IDA) ¯ un programma gratuito in esecuzione su 
Windows, Mac OS X e Linux. Molto spesso, le schede Arduino si 
basano sull'architettura Atmel AVR (microcontrollore ATmega328 con 
processore RISC a 8 bit). Il linguaggio di programmazione Arduino ¯ 
chiamato òProcessingó ed ¯ specialmente progettato per rendere la 
programmazione facile ai principianti. Supera le complessit¨ della 
programmazione tradizionale per sistemi embedded e microcontrollori 
con lõaiuto di paradigmi e software elementari. 

Invece di programmare nel linguaggio C, che ¯ molto pi½ complesso e 
difficile, gli utenti scrivono i programmi nel linguaggio òProcessingó e 
successivamente lõambiente di sviluppo integrato (IDA) trasferisce 
(converte) il programma al linguaggio C e lo carica nel controller 
tramite un cavo USB standard. 

La scheda Arduino pu¸ essere espansa montando moduli aggiuntivi, 
ampliando cos³ la sua funzionalit¨. Ad esempio, ¯ possibile aggiungere 
un modulo Ethernet, al fine di utilizzare una comunicazione di rete 
basata su TCP / IP, oppure ¯ possibile montare un modulo GSM per 
comunicare sulla rete mobile. 

- Programmazione basata su eventi e interrupt 

Eventi e interrupt sono i segnali che indicano lõoccorrenza di 
determinate condizioni nel sistema o nel programma in esecuzione, 
che richiedono lõintervento di un processore. Queste occorrenze fanno 
in modo che il processore termini lõesecuzione dellõattivit¨ in corso e 
passi a elaborare unõaltra attivit¨ o procedura speciale. Le interruzioni 
esterne sono generate da un dispositivo periferico che richiede un 
servizio. Le interruzioni software sono causate dal programma, che 
richiama una determinata istruzione, o dal processore stesso. 

Gli eventi sono occorrenze interne al processore, che indicano errori 
nell'esecuzione di un'istruzione: divisione per zero, violazione delle 
norme di sicurezza, etc. La capacit¨ del processore di rispondere ¯ 
integrata nel command loop, e gli eventi che richiedono lõattenzione 
del processore devono inviare segnali chiamati richieste di interruzioni. 
I segnali che inviano le richieste di interruzione devono essere trasferiti 
allõunit¨ centrale di controllo. 

-Sistemi embedded 

I sistemi embedded sono parte integrante della nostra vita quotidiana. 
Sono largamente utilizzati nel campo delle telecomunicazioni, 
dellõelettronica di consumo, dei trasporti e dellõindustria. Combinano 

P R E S E N T A Z I O N E  
D E T T A G L I A T A  
DELLôARGOMENTO 
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hardware e software in un dispositivo. Esempi di sistemi embedded 
sono il telecomando della televisione o quello dellõaria condizionata, 
telecamere, lettori MP3, stufe moderne, lavatrici, tv e tutti i tipi di 
elettronica di consumo. Sono specializzati in sistemi di computer e, 
come qualsiasi computer, hanno un microprocessore, dispositivi di 
memoria e periferici, tutti controllati dal software. Come qualunque 
computer, i sistemi embedded sono programmati da ingegneri del 
software che ne scrivono il codice.  

Questi specialisti sono chiamati ô Ingegneri software embeddedõ. 

I sistemi embedded sono generalmente considerati dei sistemi 
elettronici digitali, programmati per eseguire determinate funzioni in 
tempo reale. A seconda del loro scopo, sono caratterizzati da diversa 
complessit¨ ð da quella elementare (con un chip microcontrollore) a 
sistemi complessi composti da molteplici dispositivi, moduli periferici 
e di rete, montati su un chassis comune o anche integrati in un singolo 
cabinet (case). Una tendenza moderna nella loro produzione ¯ il 
desiderio di ridurre al minimo dimensioni, massa, consumo energetico 
e costi, aumentando al contempo l'affidabilit¨ e la funzionalit¨ del 
sistema. 

ĉ importante facilitare i primi passi degli studenti di scuola superiore 
nella programmazione e nello sviluppo di dispositivi elettronici. 
Bisogna farlo in un modo coinvolgente, che possa aiutarli a 
comprendere le caratteristiche di base di questi sistemi. Lõapproccio 
adottato in questa master class ¯ quello di usare semplici dispositivi e 
sistemi che possono essere esplorati per capire il processo di 
programmazione e creazione dei sistemi embedded tramite lõutilizzo di 
Arduino IDE.  

Il codice della stazione meteo domestica usato in questa master class ¯ 
disponibile online al 

http://aiut.tugab.bg/Project/meteostation/meteostation.rar  

Da questo link ¯ possibile scaricare il codice in qualsiasi browser. Sulla 
base del codice iniziale sopra riportato, ¯ possibile sviluppare molte 
possibili estensioni. Le estensioni indicative saranno suggerite agli 
studenti.  

Il codice mostra molte delle caratteristiche principali della 
programmazione con Arduino: 

¶ Installare e usare le librerie 

¶ Usare i commenti in un codice di programmazione 

¶ Definire le funzioni nel modo seguente: 

 

void setup () ð questa funzione ¯ eseguita per prima, quando il 
controller ¯ acceso. Il programmatore registra il codice inizializzando i 
terminali periferici del controller.  

 

http://aiut.tugab.bg/Project/meteostation/meteostation.rar
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Void loop () ð questa funzione si avvia immediatamente dopo che la 
funzione di setup ¯ terminata. Registra il codice del programma di 
controllo effettivo. Non appena il codice ¯ completato, la funzione 
viene riavviata automaticamente.  

Il codice che svolge le definizioni di setup e loop in C/C++ ¯ come 
mostrato nella seguente figura:  

 

pinMode () -  inizializza un pin come input o output 

digitalRead () - questa funzione legge lo stato di un input digitale 

digitalWrite () - questa funzione imposta lo status dellõoutput digitale 

analogRead () - questa funzione legge lo stato di un input analogo 

digitalWrite () - questa funzione imposta lo status di un output analogo 
(PWM) 

Serial.begin (115200) ð inizializzazione comunicazione seriale 

Serial.print () - invia dati a un computer sullõinterfaccia seriale.  

Serial.read () - legge i dati ottenuti da un computer sull'interfaccia 
seriale 

 Queste sono alcune delle caratteristiche standard usate nel 
programma. Questa sezione mostra anche le funzioni definite 
dallõutente che svolgono determinati compiti. Per esempio:  

Funzione void displayWEB () realizzazazione di una pagina WEB 
locale con le letture della pagina meteorologica. 

void parser UDP () - ricezione dei parametri del protocollo UDP da un 
computer o telefono  

bool sendToMySQL () ð invio di dati misurati a un server MySQL 
remoto.  

L'attivit¨ dovrebbe anche dimostrare l'uso di timer e interruzioni. 
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Gli istruttori possono mostrare uno dei seguenti progetti Arduino e 
discutere con gli studenti circa la loro implementazione. Possono far 
vedere dei video o un modello sviluppato in questi progetti: 

Å Robot: Vorpal the Hexapod 

https://create.arduino.cc/projecthub/vorpal-robotics-llc/robot-
vorpal-the-hexapod-4f4e90?ref=tag&ref_id=fun&offset=8   

Å Controlla la tv con il controllo del pensiero e Arduino 
http://www.tinkernut.com/portfolio/homemade-mind-controlled-tv-
remote/#lightbox[9305]/8/    

Å LED cube 

https://youtu.be/tqWAC4hu7nk  

https://youtu.be/2BlVUKW5hL0   

https://www.makeuseof.com/tag/how-to-make-a-pulsating-arduino-
led-cube-that-looks-like-it-came-from-the-future/  

Å Arduino Radar Project 

https://howtomechatronics.com/projects/arduino-radar-project/  

Å Pixel Chaser Game É GPL3+  

https://create.arduino.cc/projecthub/unexpectedmaker/pixel-chaser-
game-5929cf?ref=tag&ref_id=fun&offset=19  

Å TOP 10 dei migliori progetti Arduino di sempre| 2018 

https://youtu.be/-p_8u_0GNZE  

https://youtu.be/0XTcJ5-0u00  
  

Per ulteriori dettagli, vedi Annesso 1: Risorse di conoscenza 

 

 

 Tutti i dettagli riguardanti il codice della stazione meteo domestica, 
descritti nella ôPresentazione dettagliataõ in alto, dovrebbero essere 
presentati in modo appropriato durante la sessione introduttiva 
(intervento informativo) da una prospettiva che enfatizza il modo in 
cui il codice ¯ stato eseguito. Inoltre, il presentatore dovrebbe 
preventivante fare domande agli studenti sulle loro conoscenze 
preliminari, per creare un collegamento fra le nuove conoscenze e cosa 
gli studenti gi¨ sanno. Per esempio, se gli studenti hanno esperienza 
nella programmazione con C/CC++, il presentatore potrebbe 
descrivere il codice presentato, facendo analogie con C/C++.  

G U I D A  P E R  L A  
C O M U N I C A Z I O N E  
S C I E N T I F I C A  P E R  
G L I  I N S E G N A N T I  

 

https://create.arduino.cc/projecthub/vorpal-robotics-llc/robot-vorpal-the-hexapod-4f4e90?ref=tag&ref_id=fun&offset=8
https://create.arduino.cc/projecthub/vorpal-robotics-llc/robot-vorpal-the-hexapod-4f4e90?ref=tag&ref_id=fun&offset=8
http://www.tinkernut.com/portfolio/homemade-mind-controlled-tv-remote/#lightbox[9305]/8/
http://www.tinkernut.com/portfolio/homemade-mind-controlled-tv-remote/#lightbox[9305]/8/
https://youtu.be/tqWAC4hu7nk
https://youtu.be/2BlVUKW5hL0
https://www.makeuseof.com/tag/how-to-make-a-pulsating-arduino-led-cube-that-looks-like-it-came-from-the-future/
https://www.makeuseof.com/tag/how-to-make-a-pulsating-arduino-led-cube-that-looks-like-it-came-from-the-future/
https://howtomechatronics.com/projects/arduino-radar-project/
https://create.arduino.cc/projecthub/unexpectedmaker/pixel-chaser-game-5929cf?ref=tag&ref_id=fun&offset=19
https://create.arduino.cc/projecthub/unexpectedmaker/pixel-chaser-game-5929cf?ref=tag&ref_id=fun&offset=19
https://youtu.be/-p_8u_0GNZE
https://youtu.be/0XTcJ5-0u00
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Lõobiettivo dellõintervento informativo ¯ incoraggiare gli studenti ad 
apprendere il funzionamento e la programmazione di sistemi 
embedded, cos³ come capire il codice della stazione meteo, usato in 
questa master class. Gli studenti saranno invitati a revisionare il 
codice, nella seconda parte della master class (attivit¨ pratica). 

 

 

 

Il numero ideale di studenti partecipanti dipende dalla seconda parte 
della master class che sar¨ implementata in un laboratorio di 
informatica. Durante la seconda parte, gli studenti saranno 
organizzati in gruppi.  

 

 

  

Sala conferenze o aula magna 

 

 

 

 

Gli studenti universitari possono assumersi la responsabilit¨ di 
presentare il codice, mentre il personale universitario coordina 
lõattivit¨ e la discussione con gli studenti. Il loro ruolo ¯ molto 
importante allõinizio dellõattivit¨, quando gli studenti sono invitati a 
riportare le loro conoscenze preliminari sulla programmazione 
informatica. 

 

 

 

Fase 
no. 

Descrizione della fase Tempo 
stabilito 

1 Benvenuto; chiarificazione degli obiettivi 
della master class 

2 min 

2 Sessione rompighiaccio 

Per esempio, lõistruttore pu¸ invitare gli studenti a 
lavorare in coppia, per trovare 2-3 cose che differenzino i 
programmi eseguiti in modalit¨ real-time dagli altri; 
come usare dispositivi periferici da 5 V per i controller 
serie ESP, che funzionano a 3,3 V, ecc. 

3 min 

3 Introduzione ai sistemi embedded 10 min 

4 Presentazione della stazione meteo 
domestica 

Viene richiesto ai volontari di usare unõapplicazione 
Android per accedere alle letture della stazione meteo 

5 min 

5 Gli studenti sono invitati a rispondere alle 
seguenti domande: 

-Come funziona il Sistema? 

- Cosa succede quando si preme il pulsante 
"Riavvia" o si tocca un sensore di 

10 min 

O B I E T T I V O  

 

S E T T I N G  

L U O G O  
DELLôINTERVENTO/L

E Z I O N E   

P O S S I B I L E  
P A R T E C I P A Z I O N E  
D I  S T U D E N T I  
U N I V E R S I T A R I  
NELLôATTIVITê 

 

T E M P I S T I C H E  E  
R I E P I L O G O  

 

Scheda di pianificazione della lezione 
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temperatura? 

-Come potresti sviluppare questo sistema 
programmando o usando altri sensori 
hardware che gi¨ conosci? 

6 Presentazione del codice della stazione 
meteo 

Cfr. dettagli presentati nella ôScheda delle conoscenze 
baseõ. Qui gli studenti volontari di istruzione superiore 
possono assumere il ruolo di presentatori. 

25 min 

7 

 

 

Chiusura e spostamento verso il laboratorio 
di informatica 

Lõistruttore presenta brevemente cosa seguir¨ e che tipo di 
mixaggi gli studenti dovranno fare per essere facilitati 
nellõattivit¨.  

5 min 
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 Lõobiettivo dellõattivit¨ pratica ¯ facilitare gli studenti nello sviluppo 
della loro versione di stazione meteo, implementando revisioni ed 
estensioni possibili del codice presentato nella prima parte della master 
class. 

 

 

 Lõattivit¨ ha luogo in un laboratorio dõ informatica, dove gli studenti 
lavorano in gruppi di 2-4, a seconda dello spazio disponibile 

 

 

 Lo svolgimento della parte pratica della master class ¯ previsto nel 
laboratorio di informatica dellõuniversit¨. I computer dovrebbero 
essere connessi a Internet e Arduino IDE installato. 

 

 

 Lõattivit¨ ¯ progettata per far partecipare gli studenti universitari nel 
ruolo di facilitatori. Ogni volontario dovrebbe supportare massimo 2 
gruppi di studenti alla volta. In mancanza di volontari, questo ruolo 
pu¸ essere svolto dal personale universitario. 

Ciononostante, il coinvolgimento degli studenti universitari ¯ 
altamente auspicabile, perch® aiuterebbe gli studenti di scuola 
superiore ad essere pi½ a loro agio e in grado di parlare con loro di 
cose che esulano dalla programmazione (ad es. la vita da studente). 

 

 

 Durante questa attivit¨, gli studenti liceali saranno invitati a modificare 
il codice della stazione meteo presentato allõinizio. Verranno fornite 
loro varie idee per le estensioni che potranno mettere in pratica o 
potranno sviluppare le proprie idee.   

 

 

 Fase 
no. 

Descrizione della fase Tempo 
assegnato 

1 Organizzazione dei gruppi in modo che in 
ogni gruppo ci sia un equilibrio fra gli 
studenti che hanno precedente esperienza 
nella programmazione e quelli che non 
possiedono solide capacit¨ di 
programmazione. 

2-5 min. 

2 Breve introduzione sullõinterfaccia Arduino 
IDE  

2-5 min. 

3 Presentazione di possibili estensioni 5-10 min. 

4 Gli studenti lavorano in gruppi per 
sviluppare le loro estensioni 

Gli studenti universitari volontari svolgono il ruolo di 
facilitatori 

20-40 min 

OBIETTIVO 

 

S E T T I N G  

L U O G O  E  
M A T E R I A L E  

 

P O S S I B I L E  
P A R T E C I P A Z I O N E  
D I  S T U D E N T I  
U N I V E R S I T A R I  
NELLôATTIVITê 

 

CONTENUTO 

DELLôATTIVITê PRATICA 

 

TEMPISTICHE E 
RIEPILOGO DELLôATTIVITê 
PRATICA 

 

Scheda dellõattivit¨ pratica/ sperimentazione 
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5 Feedback e autoriflessione 

I gruppi presentano a turno le loro creazioni e riportano 
i problemi con cui si sono confrontati e le soluzioni 
trovate. Lõultima fase di riflessione pu¸ essere svolta 
nella sala conferenze o nellõaula magna in cui ¯ stato 
tenuto lõintervento iniziale.   

 

 

30-40 min 

6 Conclusioni e saluti 

 

5 min. 
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Arduino Programming and building of embedded system 
 

Editor: Stanimir Yordanov, Technical University of Gabrovo, Bulgaria 

 
E M B E D D E D  S Y S T E M S  

 
An embedded system is an electronic device that is built into a mechanical or electrical system in 
order to extend its functionality by adding new features. 

The term "embedded" indicates that the system is an integral part of another larger system or an 
integral part of the controlled device. An embedded system may be composed of several smaller 
embedded systems.  

Oftentimes, the embedded system is a component in any larger system. For example, modern 
cars contain many embedded systems. One of these systems controls the vehicle's fuel system, 
another controls emissions, and a third displays information on the dashboard. In some cases, 
these embedded systems are connected to some kind of communication network.  

The first embedded systems appeared after 1971. This is the year when Intel introduced the 
world's first microprocessor - the Intel 4004. The emergence of microprocessors resulted in the 
rapid development of embedded systems in various areas of human activity, such as space 
probes, computerized traffic lights, aircraft flight control systems, bread makers, microwave 
ovens, television sets, stereo systems, remote controls, cash registers, credit card readers, 
navigation system, etc.  

The principle of operation of an embedded system is the follows:  

-the system receives information from sensors that monitor the values of certain variables 

-based on the monitoring results and the in-built algorithm, the system controls various actuators  

-actuators control the mechanical or electrical system. 

Unlike software designed for general-purpose computers, embedded software cannot normally be 
run on other embedded systems without significant modification. This is mainly due to the 
diversity of hardware. The hardware in each embedded system is specifically tailored to the 
application for which it was designed in order to maintain low production and operating costs. 

All embedded systems contain processor and software. Where software is available, it is also 
necessary to ensure that there is a place to store executable code (FLASH and ROM memories), 
as well as to temporarily store data during runtime (RAM memory). If only a small amount of 
memory is required, it may be contained in the same chip as the processor; otherwise, external 
memory chips are required. 

All embedded systems contain inputs and outputs. For example, in a microwave oven the inputs 
are the buttons on the front panel and the temperature probe, and the outputs are the device 
display and the microwave transmitter. The outputs of an embedded system are almost always a 
function of its inputs and several other factors (time elapsed, current temperature, etc.). Typical 
inputs to the system are sensors and probes, communication signals or control knobs and 
buttons. Typical outputs are displays, communication signals, or changes in physical values.  

Figure 1 represents a generic diagram of an embedded system. The main elements of an 
embedded system are: 

Annex I: Knowledge Resource 



 

Il sostegno della Commissione europea alla produzione di questa pubblicazione non 
costituisce un'approvazione del contenuto, che rifletteesclusivamenteil punto di vista degli 
autori, e la Commissione non pu¸ essere ritenutaresponsabileper l'uso che pu¸ essere fatto 
delle informazioni ivi contenute. 

17  

¶ The computing core: It is most often based on a microcontroller, but is can also be based 
on a microprocessor, a digital signal processor (DSP), a field-programmable gate array (FPGA) 
device or an application-specific integrated circuit (ASIC). 

¶ The computing core: It is most often based on a microcontroller, but is can also be based 
on a microprocessor, a digital signal processor (DSP), a field-programmable gate array (FPGA) 
device or an application-specific integrated circuit (ASIC). 

 

O
u
tp

u
ts

Processor

RAM
 memory

FLASH (ROM) 
memory

In
p
u

ts

Embedded System

 

¶ Memory: it is used to process and store data. Memory also stores the program code. 
Depending on the type, the memory is divided into energy-dependent, volatile memory types- 
RAM, SRAM, DRAM, DDRAM and energy-independent, non-volatile memory types - ROM, 
PROM, EPROM, EEPROM, Flash. Each type of memory has its own specifics and application. 
Volatile memory is used for data processing. Non-volatile memory is used for storing the 
program, as well as storing data that must be retained after the embedded systemõs power supply 
is disconnected. 

¶ Analogue signal processing schemes: These schemes are used to pre-process the signals 
coming from the sensors. They are also used for scaling signals, filtering useful signal from 
unwanted noise, etc. 

¶ Analogue-to-digital and digital-to-analogue circuits. Analogue-to-digital conversion 
(ADC) circuits are necessary to process analogue signals from a microcontroller or from another 
digital circuit. ADC circuits convert analogue signal voltages into digital formats and they are 
mainly used to collect data from sensors that measure values monitored and controlled by the 
embedded system. Digital-to-analogue conversion (DAC) schemes, on the other hand, allow the 
values of certain variables or parameters of the embedded system software to be converted into 
analogue signals, which in turn can be used to control actuators. 

¶ Digital signals in embedded systems. As in most electronic devices, in embedded systems 
the digital signals sent to the microcontroller and other integrated circuits most often have a 
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voltage level of 3.3V or 5V. However, when it is necessary to control external devices, signals 
with higher voltage levels are required. In embedded systems, such voltage levels do not cause 
problems as electronic components are usually protected, most commonly by galvanic 
isolation between low and high voltage signals.  

¶ Timers: a timer can be programmed as a counter, which can have an additional 
configurable prescaler of its input clock, and the clock source can be selected by the software. 
Larger microcontrollers have several timers that can have different bit rates, such as 8- and 16-bit 
timers. 

¶ Communication interfaces for exchanging data: modern embedded devices contain many 
integrated circuits such as memories, analogue-to-digital and digital-to-analogue converters, 
sensors in integrated design, etc. These circuits exchange data using digital interfaces, the most 
common of which are SPI, I2C and UART interfaces. Built-in devices may also be able to 
exchange data with a personal computer using USB, Ethernet, Bluetooth and WiFi interfaces. 

¶ Visualization of information: for user convenience, an embedded device usually includes 
an indicator that can take different forms, from ordinary LEDs to modern touch-screen displays. 
The indicator enables communication with the user and it enables the user to visualize and 
change particular parameters in the software program that controls the operation of the 
embedded device. 

¶ Power supply: the power supply is an extremely important part of an embedded device. 
The power supply can be connected to the main electric network or it can be independent of it is 
it is based on batteries or a photovoltaic panel. Regardless of the power source, the voltage 
regulators in embedded systems ensure that the electronic circuits are supplied appropriate 
voltage. 

¶ Software: the embedded device would not be able to perform its function without 
appropriate software. Therefore, it is important that the operation algorithm of the device is 
properly implemented as a software program. Either assembly language (low-level programming 
language) or, more commonly, high-level programming language can be used to develop the 
software. Depending on the type of embedded system, software development is performed 
without the use of an operating system or using an operating system. When an operating system 
is used, it is most often a real-time RTOS (Real Time Operating System), characterized by high 
reliability and a predictable response time. Embedded software is also known as òfirmwareó 
because it is written to non-volatile memory and ideally will not be modified over the whole 
course of system operation, which can last for decades. In many modern systems, programs are 
stored in flash memory and can be replaced when modernization is necessary, provided that 
security protocols are followed. This enables the modernization of existing and operational 
embedded systems but also creates prerequisites for abuse. Among the most popular Operating 
Systems (OSs) for embedded systems are QNX4 RIOS, Embedded Linux, Free RTOS, Windows 
CE, etc. 

The development of embedded systems is directly related to the development of microprocessor 
systems. The emergence of novel, high-performance processors and microcontrollers has a great 
influence on modern embedded systems that are used in household appliances and a variety of 
other devices used in all human activities. The widespread use of the Internet and the 
opportunities created by Internet Protocols to remotely connect different devices is a key further 
step in the development of embedded systems. 

Trends in embedded systems development suggest that these systems will become ever more 
connected to each other through the global network and will increasingly be able to provide 
services through the Internet. Technologies that underpin the Internet of Things (IoT) are the 
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high-speed Ethernet or WiFi networks. Using these technologies, devices are able to access 
shared cloud services, where they can store in databases any information necessary for their 
operation and read this information from the cloud. 

Another emerging trend is the use of Artificial Intelligence. Thanks to Artificial Intelligence, 
embedded devices can perform functions that were, until recently, only performed by people. 
Through Artificial Intelligence and access to information on the Internet, embedded systems can 
perform analyses and autonomously make decisions in during their operation. 

 

T H E  A R D U I N O  P L A T F O R M  

 
Arduino is an open-source programmable hardware platform for handling multiple physical 
objects. It consists of a microcontroller board and a special Integrated Development 
Environment (the Arduino IDE) that is used to develop and code microcontroller software. 

Arduino can be used to develop interactive systems controlled by various sensors and switches. 
These systems, in turn, can control various indicators, motors and other devices. Arduino 
projects can be independent or they can interact with software running on a personal computer 
(e.g. Flash, Processing, MaxMSP applications). The platform consists of hardware and software, 
both of which are flexible and easy to use. 

 A simplified version of C++ known as Wiring (http://wiring.org.co/) is used for Arduino 
programming. Applications can be developed either by using the free Arduino IDE 
(https://www.arduino.cc/en/Main/Software) or by using any C / C ++ IDE. The Arduino IDE 
software is easy to understand and simple to use by beginners, while also being flexible enough 
for advanced users. It is based on the Processing language and IDE (https://processing.org), 
which makes it easy to use in education and training. High school and university students that 
have learned how to code in the Processing IDE can easily master Arduino. 

The Arduino software is open source, so experienced developers can modify and supplement it. 
Arduino language capabilities can also be expanded with C ++ libraries. 

Arduino consists of an 8-bit Atmel AVR microcontroller and optional components. An 
important aspect of the Arduino platform is the availability of standard connectors that allow 
users to connect the CPU board to variety of different interchangeable modules called òshieldsó. 
There are various interchangeable shields available on the market that can be mounted on an 
Arduino. Some shields communicate with the Arduino directly through different pin ports. 
Thanks to the I2C bus, several shields can be mounted and used at the same time.  

Most Arduino platforms operate at 5V operating voltage and feature 14 digital I/O 
(Input/Output) ports, 6 analogue inputs, a 16 MHz crystal resonator, four LEDs, a USB 
connector, a power connector, a reset button, and an ICSP (in-circuit serial programming) 
connector. The Arduino can connect to a computer through a USB cable. 

The Arduino microcontroller comes with a bootloader that makes it easy to load programs into 
the device's flash memory. This makes using Arduino easy as it allows programming to be 
performed using a simple computer. 

There are various versions of the Arduino platform - Arduino Mega, Arduino Uno, Arduino 
Nano, Arduino Mini, Arduino Ethernet, Arduino BT, Arduino Leonardo, Arduino Micro, 
Arduino Due (http://arduino.cc/). 

A number of compatible sensors and actuators have been developed for Arduino. They are used 
by reading from or writing directly into Arduino pins. Open source libraries have been developed 
for many sensors. 

https://processing.org/
http://arduino.cc/
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P R O G R A M M I N G  O F  A R D U I N O  M O D U L E S  

 
In terms of programming, all of the boards are programmed in the Arduino IDE, and no 
additional components or devices are needed to operate them. Everything is inbuilt into a 
development board that makes Arduino devices easy to work with. Arduino enjoys great 
community support around the world and a great number of libraries and examples of how to 
use the platform already exit. The official site provides detailed information about Arduino, as 
well as many sample projects for operating Arduino with peripherals (sensors, actuators, displays, 
Arduino Shields, etc.). 

As already mentioned above, Arduino developers have also created an Integrated Development 
Environment (IDE) that is simple enough to help beginner programmers and powerful enough 
to allow experienced users to build more complex projects. 

To install the Arduino programming environment, visit the company website 
https://www.arduino.cc/en/Main/Software and open a window for downloading the IDE 
software. 

 

From the page showed above, the user has to choose the Operating System (OS) on which the 
IDE has to be installed in. Clicking on the link with the correct OS will initiate the download of 
the installation file. 

Once the installation file is downloaded, it must be run. After the arduino-1.6.12-windows.hehe 
file is run, a standard license message will appear initially, which must be accepted by pressing the 
"I agree" button. 

https://www.arduino.cc/en/Main/Software
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A new window will pop up, prompting the user to select the desired actions that the installer has 
to perform. It is very important to select the "Install USB driver" option as this ensures that the 
USB port will be properly configured to work with the Arduino board. 

 

In the next step, the standard window for selecting a directory for installing the IDE will be 
displayed. In our example, the default directory is C: \  Program Files (x86) \  Arduino \ . 
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Once the "Install" button is pressed, the installation of the program will begin. As the installation 
progresses, a window will appear asking for permission to install the Arduino USB Driver. In 
order to ensure that the USB port will work properly with Arduino, the "Install" option must be 
selected. 

 

The installation will complete after this step, and a pop-up window will confirm this. To finish 
the installation, the user should press the "Close" button, after which the program can be 
launched. 
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The next step is to create a new project in the Arduino IDE. The procedure is the same for 
Windows and Linux based systems. When the IDE starts, the main window will open. It will 
contain two functions: void setup () and void loop (). The generated code will look like this: 

Including additional libraries will not be required for this project, but it is important to know how 
to include libraries in a project created in the Arduino IDE. This can be done in two ways. One 
way is to include external libraries created by someone else. Libraries should be archived as a 
RAR file, which has to be included in the Arduino environment through Sketch-> Include 
Library-> Add .ZIP Library. 
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Another way to include libraries is to create a new folder in the root directory of the Arduino 
IDE, which in our example, it is C: \  Program Files (x86) \  Arduino. From there the libraries 
folder must be selected. Inside this folder are the libraries divided into different folders. 
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When the user starts Arduino for the first time, the IDE will open a window that is ready for 
writing a program. When writing a program in the Arduino environment it is important to note 
two important functions. 

The first important function is void setup (), and the other is void loop (). The setup () function 
specifies the role that each controller pin will play and specifies the libraries that will be used. 
This part of the program is executed only once. It is followed by the loop () function, which is 
repeatedly executed and it must contain within it the actual program for operating the controller.  

Once the program is written and ready for compilation, it first needs to be saved to the userõs 
computer under a unique name. This is done by selecting the Save as command from the File 
menu or by pressing the keyboard shortcut Ctrl + Shift + S. Once saved, the program must be 
compiled. This can be done in two ways: one way is to compile without uploading the program 
onto the controller and the other is to compile and upload the program into the controller 
memory. To compile the program without uploading it onto the controller, the Verify / Compile 
option must be selected from the Sketch menu or with the keyboard shortcut Ctrl + R. An 
alternative way is to simply click the checkmark button just below the menu bar. The other 
compilation method is compilation with uploading into the memory of the controller. This can 
be done again via the Sketch menu but this time the Upload option must be selected. It can also 
be done by pressing the button depicting an arrow pointing to the right, which is directly next to 
the checkmark button, or by pressing the keyboard shortcut Ctrl + U.  

 

 

For example, we can upload a sample program from the Arduino system. The Arduino 
programming environment comes with many examples and we can use one of these programs to 
show how to compile and upload a program. 

To open a program from the examples available in the IDE, the user has to select File-> 
Examples-> Basics-> Fade from the menu. This will open a new window in which this program 
will be loaded. The user should only compile and upload the program into the controller's 
memory. 
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To upload the program onto the controller, we first need to connect the Arduino controller to 
the IDE. This is done by selecting Tools-> Port from the menu. When the user clicks on the 
Port option, another submenu will open in which the user must select the desired port to which 
the controller is connected.  

 

Once the controller is connected, the program must be uploaded into its memory. There are two 
ways to upload the program. One is by pressing the arrow button, and the other is from the 
Sketch-> Upload menu (or by pressing Ctrl + U). 
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Once the program has been compiled and uploaded into the controller's memory, òDone 
uploadingó is displayed below in the message box. This means that the program is fully loaded 
into the controller and will run almost immediately. 

 

 



 

Il sostegno della Commissione europea alla produzione di questa pubblicazione non 
costituisce un'approvazione del contenuto, che rifletteesclusivamenteil punto di vista degli 
autori, e la Commissione non pu¸ essere ritenutaresponsabileper l'uso che pu¸ essere fatto 
delle informazioni ivi contenute. 

28  

  

Development of Esp8266 Microcontroller Home-Made Weather Station 

Editor: Stanimir Yordanov, Technical University of Gabrovo, Bulgaria 

 

I N T R O D U C T I O N  

Over the last decade, we have witnessed intense changes in the behavior of climate processes. 
New records are set on fallen rain and atypically high temperatures at different points on Earth 
were measured. More and more devastating storms, droughts in many places around the world, 
as well as floods as a result of heavy rainfall, are only some of the results of climate change. 
According to some observers, it is the result of human activity, while according to others, this is 
part of natural cycles on our planet. Only time will show who is right in their claims. But in any 
case, atypical and uncharacteristic phenomena increase their frequency and strength and this 
directly affects people's lives. It is for this reason that accurate and timely reporting of weather 
indicators is extremely important in many aspects of our lives, especially those related to the 
microclimate at home or at the workplace. 

The weather station is mainly designed for monitoring current temperature, humidity and 
atmospheric pressure, dustiness and illumination monitoring. We will develop our weather station 
based on ESP8266 and programming in the Arduino IDE environment, but the data will be 
displayed on the mobile phone and recorded on a remote server. 

Main environmental parameters are: 

Å Temperature - characterizes the average kinetic energy of the particles of a macroscopic 
system in a state of thermodynamic equilibrium 

Å Air humidity  ðthe amount of water vapor in the air. 

Å Atmospheric pressure - the pressure exerted by the atmosphere on a unit of earth's 
surface 

Å Amount of rainfall ð the amount of water falling on the ground in the form of rainfall 

Å Sun exposure ð a physical quantity describing the time the sun shines directly during a 
certain time interval 

Å Airborne dust - entry of new chemical, mechanical or biological substances that are 
uncharacteristic of the air 

 

G U I D E L I N E S  F O R  D E V E L O P I N G  A  H O M E - M A D E  W E A T H E R  S T A T I O N  

Appropriate sensors, a microcontroller and management software are required for the 
development of a weather station. There are many platforms that can be used to build the station, 
but the cheapest and easiest to implement is the Arduino controller application and its 
compatible sensors. These sensors are precise enough to capture meteorological data. A 32-bit 
ESP8266 processor will be used in the present paper to develop the weather station (Figure 2). 

 

Annex II: Model hands-on activity sheet 
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Figure 2: Description of the Node MCU ESP8266 microcontroller 

The NodeMCU is built with ESP8266 based WiFi module ESP-12E. There are 10 GPIO ports, 
4MB Flash, two buttons, micro USB connector and built-in PCB antenna. The GPIO ports can 
also be used as PWM, 1-Wire and I2C. It has a 48mm x 25mm size, 4 mounting holes, and a 
2.54mm (2.54mm) gap between them compatible with Breadboard. It can be powered by a 
voltage of USB 5V or by an external power supply of 5V - 12V, connected to a Vin pin. The 
operating voltage of the GPIO ports is 3.3V. When connecting to devices and microcontrollers 
operating at 5V, it is necessary to use a converter at logical levels. The controller has a Lua 
firmware and can be programmed with the Arduino IDE thanks to the CP2102 USB-port serial 
converter.  

The following meteorological parameters can be monitored with the weather station: 
temperature, humidity, dust, atmospheric pressure, altitude, rain, sunshine. 

 

M E A S U R E M E N T  O F  T E M P E R A T U R E  A N D  H U M I D I T Y  

The DHT22 sensor is used to measure temperature and humidity. 

 

Figure 3: Connecting the DHT22 to NodeMCU 

The Humidity and Temperature Sensor - DHT22 - measures temperature ranging from - 40Á to 
80Á C, and relative humidity in the range 0% - 99%. It has a pre-calibrated digital output and is 
notable for its reliability and stability. The sensor is mounted on a 40mm x 15.4mm board. It has 
a triple interface connector and a mounting hole. It is powered by and operates at 3.3V - 5V 
voltage. 
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The scheme of the sensor connection to the controller is given in Figure 3. In order to read the 
data, it is necessary to install the library. 

The code for reading the temperature and relative humidity is as follows: 

#include <DHT.h> 
#define DHTPIN 13// D7  
#define DHTTYPE DHT22 
// Sensor initialization 
dht.begin(); 
// Measurement of the temperature and  
//  relative humidity 
float h =  dht.readHumidity(); 
float t =  dht.readTemperature(); 

 

B A R O M E T R I C  P R E S S U R E  M E A S U R E M E N T  

Atmospheric pressure is one of the most important meteorological elements. Torricelli's tubes 
were the first instrument used to measure it, and therefore atmospheric pressure is measured in 
millimetres of mercury pillar (mmHg). Later, the unit millibar /mb, mbar/ was introduced. When 
measuring atmospheric pressure in meteorology, the following types of barometers are usually 
used: 

¶ liquid barometers /mercury/ , operating on hydrostatic basis; 

¶ deformation barometers /aneroid/, based on the properties of solid bodies; 

¶ gas barometers, based on the properties of gas; 

¶ hypsothermometers or thermobarometers, based on the relationship between boiling 
point of liquids and external pressure. 

In this guide we use the BMP180 sensor manufactured by Bosch. It is designed to connect 
directly to a microcontroller or a mobile device via an I2C interface. Atmospheric pressure and 
temperature data are compensated by calibration coefficients in the E2PROM sensor memory. 
The BMP180 consists of a piezo-resistive element, an analogue digital converter and a control 
device with E2PROM memory and a serial I2C interface. The sensor produces uncompensated 
pressure and temperature data, so in the E2PROM memory there are 176 bits of calibration 
coefficients to compensate for temperature dependence and other sensor parameters. The 
microcontroller sends a request for measuring pressure or temperature.  

 

Figure 4: Connecting the BMP180 sensor to NodeMCU  
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The SFE_BMP180 library is used to measure atmospheric pressure. Here is an example of how 
to use it: 

#include <SFE_BMP180.h> 
#include <Wire.h> 
// declaration of pressure measurement object  
SFE_BMP180 pressure; 
// Initialize the measurement 
pressure.begin() ; 
// Pressure measurement 
char status; 
double T,P,p0,a;  
status =  pressure.startPressure(3); 
status =  pressure.getPressure(P,T); 
p0     =  pressure.sealevel(P,ALTITUDE ); 
a      =  pressure.altitude(P,p0); 

 

M E A S U R I N G  T H E  R A I N F A L L  L E V E L  

In meteorology the word rain is defined as both the fallen water and the water condensed on the 
earthõs surface and objects. In either case, the water may be in a liquid or solid state. All rainfall is 
due to the same reason - the low temperature of the earthõs surface and the lowest layers of air. 
The following rainfall characteristics are used in meteorology:  

¶ Quantity ð the thickness of the water layer (in mm of water column) that can be formed 
over a horizontal impermeable surface. This unit of quantity is identical to the litre per square 
meter (l / m2) unit which is used in practice. 

¶ Intensity ð rainfall per unit of time (mm/h) 

¶ Duration 

¶ Type of rainfall 

All kinds of rainfall can be monitored by weather stations. In the case of rainfall originating in 
clouds, duration and amount of precipitation for a certain period of time are being measured. For 
other types of rainfall (dew, frost, fog) only the time of occurrence is measured. 

The rain sensor module MH-RD Flying Fish is an easy tool for detecting rain. It can be used as a 
contact when the rain falls on it, as well as to measure the intensity of the falling rain. The 
module consists of two boards, one on which the water falls, and another that performs the 
measurement, both separated from each other for greater reliability, a LED lamp and a sensitivity 
adjustment potentiometer. 

 

Figure 5: Connecting the MH-RD Flying Fish to NodeMCU  
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const int  sensorMin =  0;  
const int  sensorMax =  1024; 
  
int  sensorReading =  analogRead(A0); 
// read the sensor on analog A0: 
int  sensorReading =  analogRead(A0); 
// map the sensor range (four options): 
// ex: 'long int map(long int, long int, long int, long int, long int)' 
int  range =  map(sensorReading, sensorMin, sensorMax, 0, 3); 

 

M E A S U R E M E N T  O F  S U N L I G H T  

Solar radiation in weather stations is measured by sunshine duration and intensity of light 
indicators. The BH1750FVI Sensor is used in the present paper to monitor sunshine. The 
BH1750FVI sensor is a digital ambient light sensor that uses an I2C interface. It reports a wide 
range of illuminance levels (1 - 65535 lx). It converts the light readings to a digital code. It 
consumes a small amount of electricity. It is not affected by the light source (for example: 
fluorescent lamp, mercury lamp, halogen lamp, LED, sunlight), and the influence of infrared light 
is very small.  

 

Figure 6: connecting the BH1750 sensor to NodeMCU  

The BH1750 library is used in Arduino applications: 

#include <Wire.h> 
#include <BH1750.h> 
BH1750 lightMeter; // Declaring the sensor 
lightMeter.begin();// Sensor initialization 
uint16_t lux =  lightMeter.readLightLevel(); // Measurement 

 

F I N E  P A R T I C L E  R E A D I N G  

Fine dust particles are microscopic solid or liquid substances airborne in the earthõs atmosphere. 
Sources of dust particles can be naturally occurring or artificial. Major sources are flowers (pollen 
sources), fires, diesel engines, mining, construction (sand and metals) and natural sandstorms. 
The DSM501A sensor is used to read fine particles.  

A wide-pulse modulation (WPM) signal occurs at the output of the sensor. The size of the 
detected particles that can be detected is minimum 0.7 Ǫm. The sensor determined the number of 
particles using an optical technology.  
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Figure 7: Connecting DSM501 to NodeMCU  

Measurement of particulate matter is done with the following code: 

int  pin =  15; 
unsigned long duration; 
unsigned long starttime; 
unsigned long endtime; 
unsigned long sampletime_ms =  30000; 
unsigned long lowpulseoccupancy =  0; 
float ratio =  0; 
float concentration =  0; 
pinMode(15,INPUT); 
 starttime =  millis() 
duration =  pulseIn(pin, LOW); 
 lowpulseoccupancy +=  duration; 
endtime =  millis(); 
ratio =  (lowpulseoccupancy-endtime+starttime +  sampletime_ms)/( sampletime_ms*10.0); 
concentration =  1.1*pow(ratio,3)-3.8*pow(ratio,2)+520* ratio+0.62;  

 

I N T E R N E T  C O N N E C T I O N  

The microcontroller allows connection to the Internet through its built-in wireless connection 
module - ESP8266. It can be configured as a server and can be accessed through the page it 
generates. This page is used to display the measurement data. For this purpose, a dynamic Web 
page shown in Figure 8 is built into the controller. 
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Figure 8: Web page 

 

D A T A B A S E  C O N N E C T I O N  

The controller processes and sends a request to a database, creating a table containing ten fields, 
which respectively record the IP address of the device that sends the information, the time and 
date of the recording, and the measured parameters. The recording is updated every minute. The 
saved data can be used to generate statistics, trend calls, forecasts, etc. 

 

Figure 9: Database 

 

C O N C L U S I O N  

The parameters measured by the device are temperature, humidity, barometric pressure, altitude, 
rainfall, illuminance and fine particle count. They can be monitored through the system console, 
recorded in a database, and accessed remotely. 

The opportunity to measure atmospheric parameters with the weather station and to monitor and 
analyse the results remotely allows for prognosis of changes in these parameters. The system is 



 

Il sostegno della Commissione europea alla produzione di questa pubblicazione non 
costituisce un'approvazione del contenuto, che rifletteesclusivamenteil punto di vista degli 
autori, e la Commissione non pu¸ essere ritenutaresponsabileper l'uso che pu¸ essere fatto 
delle informazioni ivi contenute. 

35  

fully automated and an algorithm is developed for the conversion of the measured information 
into physical quantities. 

 

T E S T  

1. What is the ăweather stationò? 

2. What are the basic environmental parameters? 

3. What is Arduino? 

4. What are the characteristics of the ESP8266 controller? 

5. Which sensors are used in the developed home-made weather station? 

6. How is the connection to the weather station achieved? 
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